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Abbildung 1: Das 3D Koordinatensystem

1 Einführung

1.1 Was ist jetzt überhaupt Blender?

Blender ist ein Open Source 3D Modeller, also ein Programm zum Erstellen von 3D Grafiken und 3D
Animationen, welches auf mehreren Betriebssystemen(Windows, Linux, MacOSX) zur Verfügung
steht.

1.2 Geschichte von Blender

Ursprünglich wurde Blender von Ton Roosendaal als firmeninterne Animationssoftware des nieder-
ländischen Animationsstudios NeoGeo entwickelt. Dieser Umstand spiegelt sich in der hohen Lern-
kurve und der Zentrierung von Blender auf Hotkeys wieder. Da aber Ton Roosendaal meinte, dass
Blender auch interessant wäre für andere, gründete er die Firma NaN, Not a Number, um Blender
zu vertreiben. Blender wurde als Shareware unter die Leute gebracht, wo zusätzliche Funktionalität
durch einen Schlüssel freigeschaltet werden konnte, den man kaufen musste. Auch finanzierte sich
NaN durch den Verkauf von Blender Handbüchern, welche Aufgrund von Blenders Vorliebe von
Hotkeys und keiner sonstigen Dokumentation, der einzige wirkliche Weg darstellte, Blender zu ver-
stehen. Leider konnte sich NaN dadurch nicht finanzieren und musste ca. 2002 Insolvenz anmelden.
Zu der Zeit hatte Blender schon eine beachtliche Fanbasis, wodurch die Idee geboren wurde Blen-
der von den Gläubigern freizukaufen und unter die GPL zu stellen. Nach zahlreichen Spenden, ca.
100.000 Euro um genau zu sein, konnte der Quellcode von Blender unter die GPL gestellt und die
Blender Foundation gegründet werden.

1.3 Was kann es genau?

Neben seinem Haupteinsatzgebiet der 3D Modellierung und Animation bietet Blender einen Vi-
deoschnitteditor, eine eingebaute Gameengine und eine einfache Physikengine für Spiele, die wie
Blender selbst mittels Python gescriptet werden können.

2 Begri�e

2.1 3D Koordinatensystem

Objekte, seien es Kugeln, Würfel oder ganze Todessterne, werden in Blender sowie in jeder anderen
3D Applikation wie zB. Spiele im 3D Koordinatensystem abgebildet. Was soviel wie bedeutet, dass
jedes Objekt und jeder Punkt x, y und z Koordinaten hat. Ein derartiges 3D Koordinatensystem ist in
Abbildung 1 zu sehen.

2.2 Vertex

Vereinfacht ausgedrückt ist ein Vertex ein Punkt im 3D Koordinatensystem. Wenn man von mehreren
derartigen Punkten spricht, bezeichnet man sie als Vertices.



Abbildung 2: Die Abbildung zeigt ein Edge, also eine Linie zwischen zwei Vertices

Abbildung 3: Perspektivische Ansicht eines Würfels

2.3 Face

Eine Fläche welche zwischen drei oder vier Vertices definiert wird. Eine Face ist also die Fläche die
zwischen den Eckpunkten eines Dreiecks oder eines Vierecks aufgespannt werden kann.

2.4 Edge

Stellt eine Linie zwischen zwei Vertices da.

2.5 Ansichten

Die dreidimensionale Darstellung eines Objekts stellt eine Projektion des 3D Objekts auf eine Ober-
fläche, den Computerbildschirm, da. Weshalb es mehrere Möglichkeiten gibt ein Objekt darzustellen,
die zwei bekanntesten Projektionen sind die perspektivische und die orthogonale Projektion.

2.5.1 Perspektivische Projektion

Die gewohnte Ansicht der 3D Umgebung bei der, entfernte Objekte kleiner erscheinen als nahe Ob-
jekte. Sie ist dabei schlechter zum Editieren geeignet, da es schwerer fällt Größen einzuschätzen.

2.5.2 Orthogonale Projektion

Es tritt keine perspektivische Verzerrung auf, wodurch Objekte gleicher Größe gleich groß erschei-
nen, egal wie weit sie voneinander entfernt sind.

2.6 Mesh

Stellt ein Objekt da, welches aus mehreren Vertices besteht, wobei diese untereinander Faces haben
können oder auch nicht. Sie ist die in Blender bevorzugte Objektart.

2.7 Textur

Ist ein Bild, welches auf ein Objekt abgebildet wird.



Abbildung 4: Orhtogonale Ansicht eines Würfels

Abbildung 5: Das Ergebnis des Step-by-Step Tutorials

2.8 Material

Als ein Material wird eine Sammlung von Eigenschaften bezeichnet, welche das Aussehen der Ober-
fläche eines Objekts festlegt.

3 Step-by-Step Tutorial

3.1 Was ist das Ziel des Tutorials?

Am besten für den Anfang etwas wie das hier auf Abbildung 5, also eine Kugel die gehüllt ist in ein
Drahtgitter und ein texturiertes hausähnliches Gebilde.

3.2 Step 1 - Blender runterladen und starten

Die aktuellste Version von Blender für das eigene Betriebssystem kann man von der Blender Webseite
http://www.blender.org runterladen, installieren und starten. Wobei Blender beim „ersten Mal“ ca.
so aussieht wie in Abbildung 6



Abbildung 6: Blender beim ersten Start

Abbildung 7: Klick mit rechter Maustaste auf den Fensterrahmen und „Split Area“ auswählen

3.3 Step 2 - Top/Vorder und Seitenansicht

3.3.1 3D View Fenster, Platz scha�en für Ansichten

Um für jede einzelne Ansicht, drei an der Zahl, ein eigenes Fenster zu erstellen geht man folgender-
maßen vor, man klickt den Fensterrahmen(Abbildung 7) mit der rechten Maustaste an und wählt
„Split Area“, worauf eine Trennlinie(Abbildung 8) erscheint, die zeigt wo das bestehende Fenster ge-
teilt werden soll, diese Linie lässt sich durch bewegen der Maus verschieben. Durch einen beherzten
Klick mit der linken Maustaste wird schließlich das jeweilige Fenster geteilt, falls man das nicht will,
kann man durch klicken mit der rechten Maustaste diesen, wie so gut wie alle anderen Vorgänge in
Blender abbrechen.



Abbildung 8: Die Trennlinie, welche durch bewegen der Maus verschoben werden kann

Abbildung 9: So siehts ca. nach dem Klick mit der linken Maustaste aus

Abbildung 10: Da ein Fenster noch fehlt, muss eines der beiden existierenden geteilt werden



Abbildung 11: Drei Fenster, für jede Ansicht eines, wunderbar



Abbildung 12: Die drei Ansichten Drauf(Top),Vorderansicht und Seitenansicht

Abbildung 13: Die Objekte sind außerhalb des Sichtfeldes

3.3.2 Ansichten einstellen

Jetzt wo die Fenster aufgeteilt wurden, müssen nur noch die Ansichten gewählt werden. Dazu ak-
tiviert man den Nummernblock und geht mit dem Mauscursor in jedes der erstellten Fenster und
drückt für jedes Fenster 1, 3 oder 7 auf den Nummernblock(Abbildung 12).

Die Taste 1 auf den Nummernblock wählt die Vorderansicht für das jeweilige Fenster, worin sich
der Mauscursor befindet. Um in die Seitenansicht zu wechseln drückt man die Taste 3 auf den Num-
mernblock, für die Draufansicht tippt die Taste 7 auf den Nummernblock.

Aber was soll man machen, wenn die Ansicht nicht die Objekte zeigt, wie in Abbilung 13 zu sehen
ist? Ganz einfach, man hält die Shift Taste und die mittlere Maustaste gedrückt, während man den
Mauscursor im 3D Fenster bewegt, um so den Sichtbereich zu verschieben. Es kann auch vorkom-
men, dass die Ansicht von den Objekten zu klein ist, sie also wie in Abbildung 14 kaum zu erkennen

Abbildung 14: Man kann die Objekte kaum erkennen



sind. In diesem Fall kann man bei Mäusen mit Mausrädern an diesen drehen, wobei der Mauscur-
sor sich in einem 3D Fenster befinden muss, um so zu zoomen. Falls man kein Mausrad hat, kann
man durch gedrückt halten der Strg(Steuerung) Taste und der mittleren Maustaste, bei gleichzeiti-
gem bewegen des Mauscursors in einem der 3D Fenster, auch zoomen. Diese zwei Dinge, zoomen
und Sichtbereich verschieben, funktionieren nicht nur in den 3D Fenstern, sondern auch in ein paar
anderen Fenstern von Blender, weshalb es wichtig ist, den Mauscursor immer dort zu haben wo man
diese Ansichtveränderungen auch wirklich haben will.

Daneben gibt es noch eine andere Art der Ansichtsveränderung, die es nur für das 3D Fenster
gibt. Man kann den Blickwinkel durch drücken der mittleren Maustaste und gleichzeitigen bewe-
gen des Mauscursors ändern. Falls man den Blickwinkel schrittweise nach links oder rechts kippen
will, drückt man die Nummernblocktasten 4 für nach links kippen oder 6 für nach rechts kippen.
Um schrittweise den Blickwinkel nach vorne oder nach hinten zu kippen drückt man die Nummern-
blocktasten 2 für nach vorne kippen oder 8 um den Blickwinkel nach oben zu kippen.



Abbildung 15: Falls jemand etwas über den Menüpunkt „Add“ im Blendermenü hinzufügen will,
sieht das so aus

Abbildung 16: Durch Add->Mesh->UVsphere fügt man eine Kugel der Szene hinzu

3.4 Step 3 - Objekte hinzufügen

Nun kommt die Kugel ins Spiel, welche später das Kugel-Drahtgitter werden soll. Um ein Objekt
hinzuzufügen muss man nur in eines der erstellten 3D Fenster die Leertaste drücken und im aufge-
henden Menü unter „Add“ die Objektart und danach das eigentliche Objekt, was man haben will,
auswählen. Eine andere Möglichkeit ist direkt aus dem Blendermenü den Menüpunkt „Add“ auszu-
wählen.

Jetzt fügt man eine Kugel mit dem Menüpunkt „Add->Mesh->UVsphere“ hinzu, wobei man in
dem aufgehenden Menü Einstellungen bezüglich des Objekts vornehmen kann, durch einen einfa-
chen Klick auf „Ok“ wird die Eingabe bestätigt und die Kugel der Szene hinzugefügt. Danach drückt
man die Tabulator Taste. Wichtig ist es zu wissen, dass diese Einstellungen nur bei ein paar Objekten
vorgenommen werden müssen. Auch wichtig ist es zu wissen, dass der rot–weiße Kreis, zu sehen
in Abbildung 17, an dem die Kugel erscheint, der 3D Cursor ist. Dieser kann durch klicken mit der
linken Maustaste im 3D Fenster neu positioniert werden.



Abbildung 17: Das hier ist der 3d Cursor, Objekte die hinzugefügt werden erscheinen dort wo er sich
befindet. Außerdem wird er für etliche weitere Operationen verwendet



Abbildung 18: Der Menüpunkt „Select->Select/Deselect All“ im 3D Fenster-Menü

3.5 Step 4 - Dingsda machen, also modellieren

3.5.1 Objekte selektieren

Objekte kann man durch klicken mit der rechten Maustaste auswählen, sollen mehrere Objekte aus-
gewählt werden, hält man zusätzlich die Shift Taste gedrückt. Will man mehrere Objekte aus der
Auswahl abwählen, geht man genauso vor wie wenn man mehrere Objekte auswählt.

Will man alles auswählen oder abwählen, drückt man die Taste A, wobei man das Gleiche auch
durch den Menüpunkt „Select->Select/Deselect All“ im Menü eines 3D Fensters erreichen kann.
Dieses Menü ist in Abbildung 18 zu sehen.

3.5.2 Objekte verschieben

Wir haben also eine Kamera, einen Würfel, eine Kugel und eine Lampe, aber wie verschiebt, dreht
oder skaliert man die?

Zuerst selektiert man eines der Objekte, dann drückt man die Taste G, verschiebt das Objekt nach
Belieben und klicken dann mit der linken Maustaste um das Objekt tatsächlich zu verschieben, die
rechte Maustaste bricht den Vorgang ab, so wie es bei vielen Operationen von Blender der Fall ist.
Falls sich jemand Tastenkombinationen schlecht merken kann, kann man das Gleiche auch mit dem
„Transform->Grab/Move“ Unterpunkt des „Leertasten-Menüs“ erreichen, welches mit der Leertas-
te aufgerufen werden kann. Eine andere Möglichkeit wäre den gleichen Unterpunkt des „Object“
Menüpunkts des 3D Fensters zu benutzen.

Um nun Objekte zu rotieren kann man die Taste R drücken oder den Menüpunkt „Transform-
>Rotate“ aus dem Leertasten oder dem „Object“ Menü auswählen. Ähnlich verhält es sich, wenn
man Objekte skalieren will, denn dazu kann man die Taste S drücken oder den Menüpunkt „Transform-
>Scale“ aus dem Leertasten oder dem „Object“ Menü auswählen. Jetzt wird die Kugel so verschoben,
dass die Szene ca. so wie in Abbildung 21 aussieht. Erwähnenswert ist es auch, dass die vorgestell-
ten Tasten G, R und S auch in anderen Fenstern dazu dienen, Auswahlen zu verschieben, zu skalieren



Abbildung 19: So sieht das Verschieben mit dem „Leertasten-Menü“ aus

Abbildung 20: Durch „Object->Transform->Grab/Move“ im Menü des 3d Fensters kann man das
Gleiche auch erreichen



Abbildung 21: So sollte es danach aussehen. Der Würfel und die Kugel wurden verschoben

oder falls möglich zu drehen.



Abbildung 22: Neben anderen Modi steht der Editmode zur Auswahl

Abbildung 23: Das ist der Menübereich eines Fensters

3.5.3 Editmode? Häh?

So, wir kommen jetzt endlich dazu den Würfel in etwas ganz tolles zu verwandeln, dazu aber muss
man einmal wissen, dass das Editieren nur in einem Modus geht, dem Editmode. Dieser lässt sich
nur wählen, wenn davor ein Objekt ausgewählt wurde, dass editiert werden kann. Abbildung 24
zeigt die Objektgruppen die editiert werden können.

Um in den Editmode zu gelangen stehen wieder verschiedene Möglichkeiten in Blender zur Verfü-
gung, die schnellste wäre durch drücken der Tabulator Taste, eine andere wäre durch das Auswählen
des Editmodes aus dem Modi Menü des 3d Fensters(Abbildung 22). Sollte das Modi-Menü aus ir-
gendeinem Grund verdeckt sein, kann man es dadurch wieder sichtbar machen, indem man einfach
mit der mittleren Maustaste auf den Menübereich(Abbildung 23) des 3D Fensters klickt und die
Maustaste gedrückt hält, während man die Maus nach links oder rechts bewegt um so den Bereich
zu verschieben.

Andere Objekte können nicht editiert werden und lassen sich bestenfalls verschieben, skalieren
oder drehen, ein Beispiel für ein solches Objekt ist eine Kamera. Ein Mesh in diesem Fall der Würfel
besteht aus „Vertices“, also 3D Punkte, diese werden im Editmode durch gelbe Punkte hervorgeho-
ben. Jetzt wird in den Editmode gewechselt dazu beweget man den Mauszeiger in eines der erstellten
3d Fenster, wählt den Würfel mit der rechten Maustaste aus und drückt die Tabulator Taste oder stellt
ihn durch das Modi-Menü des 3d Fensters ein.



Abbildung 24: Von links oben nach rechts unten: ein Mesh(Würfel), eine Kurve, ein Surface, zwei
Metaballs, Text, eine Amartur und eine Lattice

Abbildung 25: Der Würfel im Editmode, die gelben Punkte sind ausgewählte Vertices



Abbildung 26: Links die Region Extrusion, wo die eingeschlossene Fläche(Face)

Abbildung 27: Vier Vertices ausgewählt, die Extrusion gewählt und jetzt als Extrusionvariante Region
wählen

3.6 Step 5 - Extrusion!

Extrusion ist ein praktisches Werkzeug bei der Erstellung von Modellen, welche es ermöglicht den
Würfel in die gewünschte Form zu bringen.

Extrusion kopiert ausgewählte Vertices und verbindet sie mit den ursprünglich ausgewählten Ver-
tices mit Linien(Edges) oder Flächen(Faces). Falls die Vertices eine Fläche(Face) umgeben kann zu-
sätzlich die Kopie, diese Fläche enthalten oder nicht, wobei eine Fläche ein Dreieck oder ein Viereck
sein kann. Je nachdem wieviele Vertices man ausgewählt hat gibt es mehrere Möglichkeiten der
Extrusion, welche in Abbildung 26 gegenüber gestellt werden.

Um etwas zu extrudieren gibt es wie es sonst auch üblich ist in Blener mehrere Varianten, die
schnellste ist, wenn man die Taste E drückt und danach die Extrusionsvariante auswählt, falls meh-
rere zur Verfügung stehen, je nach Auswahl. Jetzt wird der Würfel so extrudiert das er wie in Abbil-
dung 36 aussieht

3.7 Step 6 - Aus Flächen Spitzen machen - Das Work Menü

So, wir haben jetzt den Würfel mittels Extrusion in die gewünschte Form gebracht, bis auf die Spit-
zen. Wie bekommt man die hin? Nun es gibt spezielle Editierkommandos, wobei eines, das „Remove
Doubles“ Kommando, es ermöglicht, mehrere Vertices zu einem Vertex zu verschmelzen, was wir in
diesem Fall benötigen um die Spitzen zu bilden. Die schnellste und einfachste Möglichkeit dieses

Abbildung 28: Das Ergebnis nach der ersten Extrusion



Abbildung 29: Jetzt die vorherigen Vertices abwählen zB. mit rechter Maustaste den ersten Vertex
der neuen Auswahl anklicken und danach mit Shift + rechter Maustaste die verbleibenden Vertices
selektieren. Dann wird wieder die Fläche als Region extrudiert

Abbildung 30: Danach sollte es so aussehen

Abbildung 31: Der nächste Schritt



Abbildung 32: Step by Step, heißt Step by Step, also hier der nächste Schritt, wie es aussehen sollte

Abbildung 33: Ansicht wurde gedreht um das Mesh besser zu zeigen, faktisch arbeitet man da mit
der Vorder/Drauf oder der Seitenansicht, zum Selektieren oder Extrudieren

Abbildung 34: Und der nächste Schritt in der 3D Ansicht dargestellt um das Ergebnis besser zu sehen

Abbildung 35: Vorletzter Schritt, Yeah



Abbildung 36: So sollte der Würfel am Ende aussehen

Abbildung 37: Das Work Menü



Abbildung 38: So kann man die Operation „Remove Doubles“ auch aufrufen

Abbildung 39: Blender zeigt an, wieviele Vertices bei „Remove Doubles“ zu einem Punkt verschmol-
zen und dabei gelöscht wurden

Kommando auszuführen ist das „Work“ Menü, zu sehen in Abbildung 37, welches mit der Taste W
im Editmode aufgerufen wird. Eine andere Möglichkeit wäre über den Menüpunkt „Mesh->Vertices-
>Remove Doubles“(Abbildung 38) des 3D Fensters die Operation auszuführen. Nun wählt man bei
einer der drei Flächen, die Vertices aus die die Spitzen bilden sollen. Dazu wählt man die Vertices
aus die die jeweilige Fläche bilden. Danach werden diese vier Vertices zu einem Punkt skaliert und
die Operation „Remove Doubles“, durch das Work Menü oder den Menüpunkt des 3D Fensters, aus-
geführt. Nachdem man auf „Remove Doubles“ geklickt hat, sollte eine Meldung zu sehen sein die
so aussieht wie die in Abbildung 39. Wenn 0 Vertices „removed“ wurden, dann wurde die Auswahl
nicht klein genug skaliert. Danach sollte das Ergebnis ähnlich wie Abbildung 40 aussehen. Nun
verlässt man den Editmode mit der Tabulator Taste oder dem Modi Menü eines der 3D Fenster.



Abbildung 40: Die Vertices einer Flächen wurden in einen Vertex umgewandelt



Abbildung 41: Das hier ist die Shadinggruppe im Buttons Fenster

Abbildung 42: Material Buttons aus der Shadinggruppe

3.8 Step 7 - Materialien

Jetzt gehts zu den Materialien, also dem was festlegt, wie die Oberfläche eines Objekts aussehen soll.
Zuerst wird einmal das Objekt im 3D Fenster ausgewählt, dem man ein neues Material zuordnen
will, also der veränderte Würfel. Danach wählt man die Shadinggruppe, welche in Abbildung 41
markiert ist, aus. Hat man das gemacht wählt man die Material Buttons aus, wie in Abbildung 42 zu
sehen ist. Dann klickt man auf „Add New“ um ein neues Material hinzuzufügen. Danach wird die
Kugel ausgewählt und das Gleiche nochmal gemacht, weil der Würfel wird später texturiert. Jetzt
wird die Farbe der Kugel auf rot eingestellen, das wird dadurch erreicht, indem die Slider die in
Abbildung 44 mit R,G und B beschriftet sind, bearbeiten werden. R steht für Rot, G steht für Grün,
B für Blau und A für Alpha(Sichtbarkeit), daher wenn man die Slider die mit G und B auf Null stellt
verfärbt sich die Kugel rot. Um schließlich zu erreichen, dass die Kugel als Drahtgitter gerendert
wird, muss der „Wire“ Button im markierten Bereich des Pipeline Reiters aus Abbildung 45 aktiviert
werden.

3.9 Step 8 - Spaÿ mit der Kameraperspektive

Nun ist es Zeit die Kamera auszurichten, dafür geht man mit dem Mauscursor in eines der 3D Fens-
ter und drückt die Nummernblocktaste 0, wobei der Nummernblock aktiviert sein sollte. Wenn man
alles richtig gemacht hat, dann verändert sich die Perspektive in der der Kamera, so wie es in Abbil-
dung 46 zu sehen ist. Dabei ist es wichtig zu wissen, dass was innerhalb des äußeren gestrichelten
Rahmens der Kamera zu sehen ist, ist letztendlich in der Ausgabe zu sehen, wenn Blender aus der
Sicht der Kamera ein Bild generiert. Klickt man nun auf den äußeren durchgezogenen Rahmen mit
der rechten Maustaste, so das er wie in Abbildung 47 ausgewählt ist. Kann man durch die gelernten

Abbildung 43: Die Material Buttons nachdem ein neues Material hinzugefügt wurde



Abbildung 44: Die Slider für die Farben(R,G und B) und die Sichtbarkeit, also wie sichtbar die Farbe
sein soll

Abbildung 45: Im markierten Bereich des Pipeline Reiters findet man die Einstellung das Material als
Drahtgitter zu rendern

Abbildung 46: Das sieht die Kamera zur Zeit



Abbildung 47: Die Kamera mit selektiertem Rahmen

Abbildung 48: Jetzt wird der veränderte Würfel von der Kamera gesehen

Kommandos die Kamera bewegen oder rotieren. Wobei es ein paar nette Besonderheiten bei Kame-
ras gibt, wenn man eine Kamera mit der Taste G oder dem Menüpunkt verschiebt, dann kann man
in dieser Ansicht nur die Kamera hoch oder runter bewegen, aber was ist wenn man sie in der Tiefe
auch verschieben will? Dazu klickt man mit der mittleren Maustaste und schon kann man die Ka-
mera in der Tiefe verschieben. Ähnlich verhält es sich mit dem Rotieren der Kamera, wenn man die
Kamera mit der Taste R oder dem Menü dreht, dann kann man sie nur im oder gegen den Uhrzei-
gersinn drehen, aber man kann sie nicht kippen. Um das zu machen, klicken man mit der mittleren
Maustaste und bewegt die Kamera. Jetzt wird die Kamera so ausgerichtet, dass man den Würfel
sehen kann, also so das die Ansicht wie in Abbildung 48 aussieht. Nun wird die Lampe so verscho-
ben, dass sie sich über den veränderten Würfel sich befindet, das Ergebnis sieht dann ca. so wie in
Abbildung 49 aus.



Abbildung 49: Die Lampe ist über dem Objekt und nicht mehr irgendwo, wodurch beim Rendern
kein Bild rauskommt, wo man die Objekte nicht sieht vor lauter Dunkelheit



Abbildung 50: Der Fenstertyp wird auf den UV Editor gestellt, wodurch sich das jeweilige Fenster in
den UV Editor „verwandelt“

3.10 Step 9 - Texturieren

Jetzt kommt die versprochene Texturierung des ehemaligen Würfels, dafür muss man wissen, dass
Blender mehrere Arten der Texturierung kennt und auch ein paar fertige prozedurale Texturen ein-
gebaut hat, was soviel bedeutet, dass Blender diese Texturen errechnet. Das Tutorial beschränkt sich
bei der Texturierung nur auf die sogenannten UV-Texturen, bei denen man jedem Punkt eines 3D Ob-
jekts einer Koordinate eines Bildes zuweist, diese Koordinaten sind in dem Fall U und V, daher der
Name UV-Textur. UV-Texturen werden hauptsächlich für Computerspiele oder andere Anwendun-
gen verwendet, wo es wichtig ist, ganz genau zu steuern wie eine Textur auf ein Objekt abgebildet
wird. In Blender sieht der Vorgang dazu folgendermaßen aus, zuerst müssen die UV Koordinaten
mit einem eigenen Editor dem UV Editor zugeordnet werden, danach wird das Bild als Textur gela-
den und dem Material des Objekts zugeordnet, zuletzt wird die Verwendung der mit dem UV Editor
ermittelten UV Koordinaten aktiviert.

3.10.1 Flächen(Faces) wählen

Zuerst wird der veränderte Würfel ausgewählt und danach im Modi Menü des 3D Fensters, der „UV
Face Select“ Mode ausgewählt, danach kann man die einzelnen Flächen(Faces) auswählen um ihnen
später im UV Editor Bildausschnitte eines Bildes zuordnen.

3.10.2 UV Editor

Um in den UV Editor zu gelangen stellt man den Fenstertyp eines Fensters auf „UV/Image Editor“
wie es in Abbildung 50 dargestellt ist. Danach ladet man durch den in Abbildung 51 angezeigten
Menüpunkt „Image->Load“ des UV/Image Editors ein Bild in den Editor. Das Selektieren der einzel-
nen oder mehrere Vertices funktioniert im Editor genauso wie im 3D Fenster. Genauso funktioniert
das Bewegen, Rotieren oder Skalieren der einzelnen Vertices im Editor, also mit den Tasten G, R oder
S.



Abbildung 51: Durch diesen Menüpunkt ladet man das Bild in den UV Editor anhand dem man die
UV Koordinaten ermitteln will

Abbildung 52: Das ist der Texturen Reiter des Materials des veränderten Würfels, durch klicken auf
„Add new“ fügt man eine neue Textur hinzu

3.10.3 Textur generieren

Nachdem man fertig ist mit dem zuordnen der UV Koordinaten ändert man den Fenstertyp von
„UV/Image Editor“ wieder auf den vorherigen Fenstertyp und stellt den Modus zurück auf „Object
Mode“. Danach stellt man sicher, dass der veränderte Würfel ausgewählt ist und wechselt zu seinem
Material und fügt eine neue Textur hinzu, indem man auf „Add new“ im Textur Reiter des Materials
klickt, welcher in Abbildung 52 zu sehen ist. Als nächstes wählt man die Texture Buttons aus, welche
in Abbildung 53 hervorgehoben sind. Dort wählt man den Texturen-Typ „Image“ aus so wie es
in Abbildung 54 gezeigt wird, danach wird im Reiter „Image“ mittels dem Button „Load“, der in
Abbildung 55 hervorgehoben ist, das Bild geladen.

Abbildung 53: Rot hervorgehoben sind die Texture Buttons



Abbildung 54: So wählt man den Texturen-Typ „Image“ aus

Abbildung 55: Danach ladet man das Bild mittels dem Knopf „Load“ aus einer Datei



Abbildung 56: Durch anklicken des „UV“ Button im rot hervorgehobenen „Map Input“ Reiter, ordnet
man die UV Koordinaten der Textur zu

Abbildung 57: Die Render Buttons, in der Scene Obergrupppe

3.10.4 UV Koordinaten zuordnen

Jetzt wird wieder zu den Material Buttons gewechselt und durch anklicken des Buttons „UV“ im
„Map Input“ Reiter(Abbildung 56), wird die Verwendung von den definierten UV-Koordinaten ak-
tiviert.

3.11 Step 10 - Rendern

Nun, jetzt haben wir so gut wie alles, jetzt fehlt nur noch die Ausgabe, also ein Bild generieren. Wie
macht man das? Ganz einfach, man wählt unter „Scene“ die „Render Buttons“ aus, so das das „But-
tons“ Fenster wie in Abbildung 57 aussieht. Dort stellt man in der in Abbildung 58 hervorgehobenen
Liste das gewünschte Ausgabeformat ein und klickt danach auf den in Abbildung 59 hervorgehobe-
nen Button mit der Aufschrift „Render“. Wenn man alles richtig gemacht hat, dann startet sich der
Renderprozess und Blender erstellt ein Bild, was man durch auswählen des Menüpunkts „File->Save
Image“ des Blendermenüs, welches in Abbildung 60 dargestellt ist, abspeichern kann.

Abbildung 58: Das ist der Format Reiter, rot markiert ist die Liste mit den Ausgabeformaten



Abbildung 59: So sieht der „Render“ Reiter in der „Render Buttons“ Ansicht des „Buttons“ Fensters
aus. Rot hervorgehoben ist der „Render“ Button, mit ihm startet man den Renderprozess

Abbildung 60: Das „File“ Menü von Blender, mit „Save Image“ kann man das zuletzt gerenderte Bild
speichern
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